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How	to	adjust	brightness	and	contrast	in	paint	3d

Brightness—controls	the	lightness/darkness	of	the	image.	Drag	the	slider	to	the	left	to	decrease	brightness,	drag	to	the	right	to	increase	it.	Contrast—controls	the	tonal	range	of	the	image.	Drag	the	slider	to	the	left	to	decrease	the	contrast	between	dark	and	light	areas,	drag	to	the	right	to	increase	it.	Linear—by	default,	the	adjustment	prevents
shadow	and	highlight	clipping	by	modifying	pixels	relative	to	their	original	lightness	value.	When	selected,	this	option	modifies	pixels	using	absolute	values	and	clipping	may	occur.	1.	Use	Paint	Open	the	Paint	app.	Select	File	and	open	the	image	you	want	to	pixelate.	Click	on	Select	from	the	toolbar,	and	then	click	on	Rectangularselection.	Make	a
rectangle	on	the	picture.	Click	on	a	corner	and	make	the	rectangle	small.	Make	the	rectangle	really	large.	Click	to	see	full	answer.	Considering	this,	how	do	you	blur	something	in	Paint	3d?	(Using	MS	Paint)	Go	to	Microsoft	Paint	and	paste	the	Image	that	has	toblurred.	Move	to	'Select'	and	then	choose	'Rectangular	Section'	option.Now	select	the
required	area	to	blur.	Choose	the	'Resize'option–>Pixels–>Untick	the'Maintain	aspect	ratio'	option.	STEP	4:Drag	the	selected	text	and	then	click	save.	Similarly,	how	do	you	write	in	3d	paint?	How	to	Create	3D	Text	in	Paint	3D	Open	Paint	3D	and	click	New	to	start	a	new	project.	Select	text	tool	from	the	menu	bar	at	the	top,	or	just	press“T”	on	your
keyboard.	Select	the	three	dimensional	icon	from	the	sidebar	(3Dtext).	Click	anywhere	on	the	canvas	and	start	typing.	Click	anywhere	on	the	canvas	outside	of	the	text	box	to	turn	it3D.	One	may	also	ask,	how	do	you	blur	a	painting?	Use	a	soft-bristled	brush	to	gently	push	around	the	still-wetpaint	to	soften	lines	and	blur	features.	A	stiff-bristled	brush
canleave	marks.	Place	plastic	wrap	over	the	area	of	the	painting	you	wish	toblur.	Use	a	squeegee	or	soft	scraper	for	photographic	blurringeffects.	Does	Paint	3d	have	a	blur	tool?Microsoft's	Paint	program	doesn't	have	ablur	setting,	but	you	can	make	a	picture	lookblurred	by	decreasing	its	size	and	then	increasing	it	againto	add	pixels	to	it.	Professional
How	to	blur	an	image?	Open	your	photo	in	Raw.pics.io	by	hitting	START.	Select	Edit	on	the	left	side	panel.	Find	Blur	tool	in	the	right	toolbar.	Click	on	Blur	until	you	achieve	the	necessary	blurringeffect.	Save	your	blurred	image.	Professional	Blur	effect	in	MS	PAINT	Step	1:	Click	Select	tool	from	the	toolbar.	Step	2:	Draw	an	outline	around	or	select	an
area	that	you	wishto	blur.	Step	3:	Re-size	the	selected	area	by	holding	one	of	the	edgeand	drag	it	inward	to	make	it	smaller	than	the	original	size	andthen	drag	it	outward	to	bring	it	back	to	original	size.	Professional	Method	1	Blending	Wet	Paint	with	Wet	Paint	Start	with	a	damp	brush.	Paint	one	color	in	large	strokes	across	the	top	of	yourcanvas.
Brush	a	little	bit	of	the	second	color	across	the	canvas.	Use	a	bit	more	of	the	second	color	below	the	first	color.	Finish	off	at	the	bottom	with	just	the	new	color.	Explainer	Pixelate	Your	Photo	If	you	want	to	pixelate	an	image,	all	you	haveto	do	is	resize	it	a	few	times.	Select	"File"	and	then	"Open"	tobring	your	image	of	choice	into	Paint.	Choose	the
"Select"tool	from	the	toolbar	and	click	and	drag	to	select	your	photo,placing	a	dotted	border	around	it.	Explainer	Select	the	Sharpen	layer	in	the	Layers	Window.Adjust	the	brightness/contrast	of	the	Sharpen	layer	usingthe	Brightness	/	Contrast	adjustments.	ChooseAdjustments>Brightness	/	Contrast	or	else	just	pressCtrl+Shift+T.	The	Brightness	/
Contrast	dialogappears.	Explainer	Method	1:	Blur	Images	by	Resizing	Selected	Area	Import	the	photo	you'd	like	to	blur	and	then	click	on	theSelect	tool	in	the	toolbar.	Proceed	to	select	the	area	of	the	image	you	want	to	blur.	Drag	the	edge	of	the	rectangle	you	just	made	to	resize	theselected	area.	Pundit	Click	or	tap	the	Start	Menu	button	in	the
lowerleft-hand	corner	of	the	Windows	10	desktop	and	select	theSettings	icon.	Choose	Personalization	from	the	list	of	settings	andselect	the	Colors	item	found	in	the	left-hand	navigation	menu.Scroll	down	the	page	until	you	see	Transparency	effects,	as	shownin	Figure	A.	Pundit	Start	Word	and	open	a	document	in	which	you	want	to	blur	sometext.
Select	the	text	you	want	to	blur	by	clicking	your	mouse	anddragging	over	the	text.	Click	on	the	"Text	Effects"	drop-down	arrow	in	the	Font	groupon	the	Home	tab	of	the	Word	ribbon.	Pundit	Blur	part	of	a	picture	with	PowerPoint	In	PowerPoint,	use	File	>	Insert	to	put	the	picture	on	aslide.	Use	Insert	>	Shape	to	draw	a	shape	over	the	area	you	want
toblur.	On	the	Format	tab,	select	Shape	Fill	>	Eyedropper.	With	the	Eyedropper,	click	a	part	of	the	picture	whose	colorapproximates	the	color	you	want	the	blurred	shape	to	be.	Pundit	First,	choose	a	color	from	the	colorpalette,	or	use	the	eyedropper	to	pick	up	a	color	already	inyour	workspace.	If	you	want	to	add	custom	colors	to	yourpalette,	select	+
Add	color.	Once	you	have	the	perfectcolor,	select	a	brush	to	use	and	paint	right	onto	thecanvas.	Teacher	How	to	Blur	Faces	and	Text	in	Photoshop	There	are	plenty	of	reasons	you	might	want	to	blur	some	part	ofa	photo	in	Photoshop.	Select	the	Marquee	Tool	from	the	Tool	Bar,	or	with	the	keyboardshortcut	M.	Draw	a	selection	around	the	area	of	the
image	you	want	toblur.	Go	to	Filter	>	Blur	>	Gaussian	Blur.	Teacher	Click	and	drag	your	mouse	cursor	over	the	part	of	theimage	you	want	to	blur.	Click	"Filters"	from	the	menu	bar,hover	the	cursor	over	"Blur,"	and	then	select	the	type	ofblur	that	you	want	to	apply	from	the	list	of	options.	Adjustthe	settings	for	the	type	of	blur	that	you	areapplying.
Teacher	Select	the	"Text"	tool	and	click	to	place	atext	box.	As	long	as	the	text	box	is	open,	you'refree	to	edit	the	text.	If	you're	wondering	how	tochange	the	color	of	text	in	paint,	in	addition	totyping	or	deleting	text,	use	the	settings	on	the	menu	bar	toedit	the	text's	formatting,	such	as	font,	size	andcolor.	Teacher	Paint	3D	Text	After	choosing	one	of	the
text	tools,	click	anddrag	anywhere	on	the	canvas	to	open	a	text	box	that	you	canwrite	in.	The	text	options	to	the	right	let	youchange	the	text	type,	size,	color,	alignment	withinthe	box,	and	more.	Reviewer	In	Windows	10	photo	App	there	is	no	such	option	toadd	text	to	the	photo.	Please	follow	the	below	steps.	In	search	tab	type	“Paint”,	once	you	find
doubleclick	on	the	app.	Import	the	Image	which	you	want	to	edit.	Select	Text	edit	option	and	add	your	text.	Reviewer	Open	Paint	and	click	the	text	tool,	whichlooks	like	an	“A”	in	the	Tools	area	of	the	ribbon.Click	the	white	Paint	workspace,	which	opens	the	TextTools	tab.	Click	the	"Font	Size"	down	arrow	on	the	ribbonand	choose	a	larger	size.	You	can
also	type	and	thenhighlight	the	text	and	make	it	bigger	using	thismenu.	Reviewer	Select	text	in	Paint.net	To	add	text	select	the	text	tool	and	click	somewhere	on	an	openimage.	To	remove	text,	use	backspace	to	delete	the	text	as	you	seefit.	To	select	text,	click	on	the	little	square	icon	in	the	bottomright	of	the	text	window.	Reviewer	To	get	started,
select	the	Stickers	iconon	the	top	menu,	then	select	a	shape,	a	sticker	decal,	ortexture	to	add	to	your	2D	canvas	or	3D	model.	Once	you'veselected	the	sticker	you	want,	click	and	drag	tocreate	it	right	in	your	workspace.	Then,	rotate	or	resizeyour	sticker	using	the	box	that	appears	aroundit.	Supporter	Press	and	hold	down	the	left	mouse	button	inside
theselection	box	and	move	your	picture	to	relocate	the	image.	If	youwish	to	copy	the	image,	right-click	inside	the	selection	boxand	click	"Copy."	You	can	then	paste	the	image	to	anotherpaint	document	or	in	another	program.	The	Smart	Brush	tool	and	the	Detail	Smart	Brush	tool	apply	tonal	and	color	adjustments	to	specific	areas	of	a	photo.	Certain
effects	can	also	be	applied	using	these	tools.	You	simply	pick	a	preset	adjustment	and	apply	the	correction.	Both	tools	automatically	create	adjustment	layers.	This	feature	offers	you	flexibility	in	working	with	your	photos	because	the	original	image	layer	is	not	altered.	You	can	go	back	and	tweak	the	adjustments	and	no	image	information	is	discarded.
When	you	apply	the	Smart	Brush	tool,	it	makes	a	selection	based	on	color	and	texture	similarly.	The	adjustment	is	simultaneously	applied	to	the	selected	area.	You	can	adjust	shadows,	highlights,	colors,	and	contrasts.	Apply	colors	of	the	objects	in	your	image,	add	textures,	apply	various	photographic	effects.	Smart	Brush	tool	applying	an	adjustment
selection	Select	the	Smart	Brush	tool.	Select	an	effect	from	the	preset	drop-down	in	the	Tools	Options	bar,	and	then	drag	your	mouse	on	the	objects	in	the	image	to	which	you	want	to	apply	the	effect.	You	can	apply	various	effects	and	patterns	using	smart	brush	from	the	available	preset	options.	Available	presets	However	you	cannot	change	the
settings	of	an	effect	because	the	layer	with	the	effect	is	a	pixel	layer	and	not	an	adjustment	layer.	Textures	option	The	Textures	presets	help	provide	the	following	effects	to	your	images:	Enhance	dull	and	boring	backgrounds.	Create	a	Satin	effect	for	clothes/textiles	in	an	image.	Add	flowery	patterns	to	dresses	in	an	image.	Add	designer	patterns	to
walls	or	backgrounds	in	an	image.	The	Detail	Smart	Brush	tool	enables	you	to	paint	the	adjustment	to	specific	areas	of	the	photo	just	like	a	painting	tool.	This	tool	helps	adjust	fine	details	with	pattern	and	effect	presets.	Painting	and	applying	the	preset	in	small	areas	is	more	precise.	Click	an	effect	from	the	drop-down	list	and	paint	over	the	area	to
apply	the	effect.	You	can	choose	from	a	range	of	brushes.	It	has	settings	for	brush	size	and	shape	in	the	options	bar.	It	also	works	like	a	Selection	tool;	you	can	click	Refine	Edge	in	the	options	bar	to	modify	the	selection’s	shape	and	size.	To	remove	an	area	from	the	selection,	click	the	Remove	area	from	Selection	brush.	Both	brush	tools	enable	you	to
add	to	or	subtract	from	the	areas	being	adjusted.	You	can	also	have	more	than	one	adjustment	preset	applied	to	a	photo.	Each	preset	adjustment	is	applied	to	its	own	adjustment	layer.	You	can	tweak	the	settings	for	each	correction	separately.	When	a	correction	is	made,	a	pin	appears	where	you	first	applied	the	adjustment.	The	pin	provides	a
reference	for	the	specific	adjustment.	A	new	pin	appears	when	a	different	adjustment	preset	is	applied.	This	feature	makes	it	easier	to	modify	a	specific	correction,	especially	if	you	apply	different	adjustments.	Detail	Smart	Brush	tool	applying	an	adjustment	stroke	Select	the	Smart	Brush	tool	or	the	Detail	Smart	Brush	tool	from	the	toolbox.	A	pop-up
panel	opens	displaying	adjustment	presets.	Select	an	effect	from	the	preset	drop-down	in	the	Tools	Options	bar.	Choose	an	option	from	the	pop-up	panel	menu	to	view	different	sets	of	adjustments.	For	more	information	on	configuring	the	pop-up	panel,	see	About	presets.	(Optional)	Adjust	the	size	and	quality	of	the	brush	tool	by	doing	one	of	the
following:	If	you	selected	the	Smart	Brush	tool,	open	the	Brush	Picker	in	the	options	bar	and	adjust	the	settings.	If	you	selected	the	Detail	Smart	Brush	tool,	select	a	preset	brush	tip	from	the	Brush	presets	pop-up	panel.	Then	adjust	the	brush	size	setting	in	the	options	bar.	Paint	or	drag	the	tool	in	the	image.	The	correction	is	applied	on	its	own
adjustment	layer	and	a	color	pin	appears	where	you	first	applied	the	brush	tool.	(Optional)	Do	any	of	the	following:	To	add	the	current	adjustment	to	more	areas	of	the	photo,	paint	or	drag	in	the	image.	If	necessary,	make	sure	Add	To	Selection	is	selected.	To	remove	parts	of	the	current	adjustment,	select	Subtract	From	Selection	and	paint	in	the
image.	To	apply	a	different	type	of	adjustment,	select	New	Selection,	select	a	preset	from	the	pop-up	panel,	and	then	paint	in	the	image.	If	you	use	a	different	tool	from	the	toolbox	and	then	return	to	the	Smart	Brush	tool	or	Detail	Smart	Brush	tool,	the	last	adjustment	you	applied	is	active.	(Optional)	If	you	have	multiple	adjustments,	do	one	of	the
following	to	select	the	adjustment	you	want	to	add	to,	subtract	from,	or	modify:	Right-click	in	the	photo	and	choose	the	adjustment	listed	in	the	bottom	portion	of	the	menu.	Modify	Smart	Brush	tool	correction	settings	In	the	image,	right-click	a	pin	or	an	active	selection	and	choose	Change	Adjustment	Settings.	In	the	Layers	panel,	double-click	the
layer	thumbnail	for	the	specific	adjustment	layer.	Adjust	the	settings	in	the	dialog	box	and	then	click	OK.	Change	the	Smart	Brush	tool	correction	preset	Click	a	pin	or	active	selection	and	then	open	the	preset	pop-up	panel	in	the	options	bar.	Choose	an	adjustment	preset	from	the	pop-up	panel.	Delete	a	Smart	Brush	tool	correction	Right-click	a	pin	or
an	active	selection	and	choose	Delete	Adjustment.	In	the	Layers	panel,	you	can	also	delete	a	Smart	Brush	tool	correction	by	deleting	the	specific	adjustment	layer.	Photoshop	Elements	lets	you	apply	many	different	preset	adjustments	using	the	Smart	Brush	tool	and	the	Detail	Smart	Brush	tool	.	You	pick	an	adjustment	from	the	preset	pop-up	panel	in
the	options	bar.	Like	all	pop-up	panels,	the	Smart	Brush	preset	pop-up	panel	can	be	configured.	Use	the	panel	menu	to	display	the	adjustments	as	thumbnails	or	in	a	list.	You	can	also	drag	the	picker	out	of	the	options	bar	so	it	floats	where	you	want	it	in	the	workspace.	Specific	sets	of	adjustments	or	all	adjustments	can	be	viewed	by	choosing	from	a
menu	near	the	upper-left	area	of	the	panel.	The	adjustments	range	from	tonal	and	corrections.	The	Levels	dialog	box	is	a	powerful	tonal	and	color-adjustment	tool.	You	can	make	levels	adjustments	in	the	entire	image	or	a	selected	portion.	(To	access	the	dialog	box,	choose	Enhance	>	Adjust	Lighting	>	Levels.)	You	can	do	any	of	the	following	with	the
Levels	dialog	box:	Levels	dialog	box	A.	Channels	to	adjust	color	B.	Shadow	values	C.	Middle	tones	D.	Highlight	values		Set	the	shadow	and	highlight	values	to	make	sure	that	your	image	uses	the	full	tonal	range.	Adjust	the	brightness	of	the	image’s	middle	tones	without	affecting	the	shadow	and	highlight	values.	Fix	a	color	cast	by	making	grays
neutral.	You	can	also	enhance	an	image	by	adding	a	slight	color	cast,	for	example,	by	adding	a	warming	effect	on	a	sunset.	Target	shadow	and	highlight	RGB	values	if	you	are	preparing	images	for	commercial	printing.	When	you	work	with	Levels,	you	can	work	directly	on	the	image	pixels	or	through	an	adjustment	layer.	Adjustment	layers	give	you
flexibility	in	the	following	ways:	You	can	modify	an	adjustment	at	any	time	by	double-clicking	the	adjustment	layer	to	reopen	the	Levels	dialog	box.	You	can	reduce	the	effect	of	an	adjustment	by	lowering	the	adjustment	layer’s	opacity	in	the	Layers	panel.	You	can	stack	adjustment	layers	to	make	multiple	adjustments	without	degrading	the	image
because	of	too	many	successive	adjustments.	You	can	use	the	adjustment	layer’s	layer	mask	to	confine	an	adjustment	to	a	portion	of	your	image.	Improve	shadow	and	highlight	detail	Choose	Enhance	>	Adjust	Lighting	>	Shadow/Highlights.	Drag	any	of	the	adjustment	sliders	or	enter	values	in	the	text	boxes,	then	click	OK.	Brightens	the	dark	areas	of
your	photo	and	reveals	more	of	the	shadow	detail	that	was	captured	in	your	image.	Darkens	the	light	areas	of	your	photo	and	reveals	more	of	the	highlight	detail	that	was	captured	in	your	image.	Pure	white	areas	of	your	photo	don’t	have	any	detail	and	aren’t	affected	by	this	adjustment.	Adds	or	reduces	the	contrast	of	the	middle	tones.	Use	this	slider
if	the	image	contrast	doesn’t	look	right	after	you’ve	adjusted	shadows	and	highlights.	To	reset	the	image	to	how	it	looked	when	you	opened	the	dialog	box,	hold	down	Alt	(Option	in	Mac	OS)	and	click	the	Reset	button.	Before	adjusting	shadows	and	highlights	(top)	and	after	(bottom).	Adjusting	softens	the	face	and	reveals	more	detail	behind
sunglasses.	Adjust	shadows	and	brightness	using	Levels	Choose	Enhance	>	Adjust	Lighting	>	Levels.	Choose	Layer	>	New	Adjustment	Layer	>	Levels,	or	open	an	existing	Levels	adjustment	layer.	Choose	RGB	from	the	Channel	menu.	When	set	to	RGB,	your	adjustment	affects	all	three	(red,	green,	and	blue)	channels.	If	you	are	working	on	a	grayscale
image,	it	will	only	have	the	gray	channel.	Set	the	shadow	and	highlight	values	by	dragging	the	black	and	white	Input	Levels	sliders	(the	left	and	right	sliders	directly	under	the	histogram)	to	the	edge	of	the	first	group	of	pixels	on	either	end	of	the	histogram.	You	can	also	enter	values	directly	into	the	first	and	third	Input	Levels	text	boxes.	Dragging	the
highlight	slider	to	the	left	lightens	the	photo.	Press	Alt	(Option	in	Mac	OS)	and	drag	the	Shadow	slider	to	see	which	areas	will	be	clipped	to	black	(level	0).	Press	Alt	(Option	in	Mac	OS)	and	drag	the	Highlight	slider	to	see	which	areas	will	be	clipped	to	white	(level	255).	Colored	areas	show	clipping	in	individual	channels.	To	adjust	the	brightness	of	the
middle	tones	without	affecting	the	shadow	and	highlight	values,	drag	the	gray	Input	Levels	(middle)	slider.	You	can	also	enter	values	directly	in	the	middle	Input	Levels	text	box.	(A	value	of	1.0	represents	the	current	unadjusted	midtone	value.)	Click	OK.	You	can	see	the	adjustment	reflected	in	the	Histogram	panel.	You	can	click	Auto	to	move	the
Highlight	and	Shadow	sliders	automatically	to	the	brightest	and	darkest	points	in	each	channel.	This	is	the	same	as	using	the	Auto	Levels	command	and	may	cause	a	color	shift	in	your	image.	Adjust	brightness	and	contrast	in	selected	areas	The	Brightness/Contrast	command	is	best	used	on	selected	portions	of	an	image.	Use	this	command	to	adjust
the	brightness	of	an	entire	image	or	to	reduce	contrast	results	in	an	image.	The	Levels	and	Shadow/Highlight	commands	are	better	choices	for	making	tonal	adjustments.	Choose	Enhance	>	Adjust	Lighting	>	Brightness/Contrast	to	make	adjustments	directly	to	image	pixels.	Choose	Layer	>	New	Adjustment	Layer	>	Brightness/Contrast	to	make
adjustments	to	a	layer.	Drag	the	sliders	to	adjust	the	brightness	and	contrast,	then	click	OK.	Dragging	to	the	left	decreases	the	level;	dragging	to	the	right	increases	it.	The	number	at	the	right	of	each	slider	displays	the	brightness	or	contrast	value.	Quickly	lighten	or	darken	isolated	areas	The	Dodge	tool	and	the	Burn	tool	lighten	or	darken	areas	of
the	image.	You	can	use	the	Dodge	tool	to	bring	out	details	in	shadows	and	the	Burn	tool	to	bring	out	details	in	highlights.	Original	image	(left),	after	using	the	Burn	tool	(top	center),	and	after	using	the	Dodge	tool	(bottom	right)	Select	the	Dodge	tool	or	the	Burn	tool.	If	you	do	not	see	these	tools,	look	for	the	Sponge	tool.	Set	tool	options	in	the	options
bar:	Sets	the	brush	tip.	Click	the	arrow	next	to	the	brush	sample,	choose	a	brush	category	from	the	Brushes	pop‑up	menu,	and	then	select	a	brush	thumbnail.	Sets	the	size	of	the	brush,	in	pixels.	Drag	the	Size	slider	or	enter	a	size	in	the	text	box.	Sets	the	image	tonal	range	that	the	tool	adjusts.	Select	Midtones	to	change	the	middle	range	of	grays,
Shadows	to	change	the	dark	areas,	and	Highlights	to	change	the	light	areas.	Sets	the	effect	of	the	tool	with	each	stroke.	A	higher	percentage	increases	the	effect.	Tip:	To	dodge	or	burn	an	area	gradually,	set	the	tool	to	a	low	exposure	value	and	drag	several	times	over	the	area	you	want	to	correct.	Drag	over	the	part	of	the	image	you	want	to	modify.
Quickly	saturate	or	desaturate	isolated	areas	The	Sponge	tool	saturates	or	desaturates	areas	of	the	image.	You	can	use	the	Sponge	tool	to	bring	out	or	mute	the	color	on	an	object	or	area.	Select	the	Sponge	tool.	If	you	do	not	see	the	Sponge	tool,	look	for	the	Dodge	or	Burn	tool.	Set	the	tool	options	in	the	options	bar.	Sets	the	brush	tip.	Click	the	arrow
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